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Chapter 1. Introduction
Monterey Barcode Creator is an easy-to-use program that lets anyone draw and print barcode labels. You do
not have to know barcode terms in order to create quality barcodes.
The software comes with the following feature hightlights:

• The program supports most linear barcode formats, including Code 39, UPC-A, UPC-E, EAN-13, EAN-8,
Code 93, Code128, UCC/EAN-128, Codabar, POSTNET, Royal Mail, HIBC and Interleaved 2 of 5.

• The program exports the barcode images to a variety of graphics formats, including BMP, JPEG, GIF,
PNG, TIF, WMF and EMF.

• The program provides more than two dozen properties that allow users to get the barcode they
desired.

• The program does not only create barcode images; it also creates human readable and comment. In
addition, it allows flexible placement of these elements.

• The program has a built-in label database with more than 1,500 widely used label paper templates.
• The program now supports batch printing from a number sequence or a data file.
• The program can act as an OLE server to embed itself into a Microsoft Office document. This method

produces better quality barcodes than pasting a metafile or bitmap image.

1.1. How to Read this manual
If you never have experience with barcode label, we recommend that you read from Chapter 2, Get Started to
get an idea how this program works. You might want to follow the tutorial to create your first barcode.
Chapter 5, Printing Barcodes outlines the necessary steps to print barcodes out to a printer. This chapter should
be read thoroughly, especially if you plan to use the batch printing feature.
If your emphasis is on integrating barcodes into Microsoft Office documents, read Chapter 6, Using Barcode
Creator in MS Word, Excel and other programs.
At last, read Chapter 7, Barcode Properties Reference. You may need to go back there to lookup some parameters
from time to time.
If you are not familiar with the barcode format you are working with, Chapter 8, Barcode Technologies will give
you a brief idea about all the symbologies this program supports.





Chapter 2. Get Started

2.1. System Requirements
Monterey Barcode Creator requires the following systems:

1. Microsoft Windows® 7, Windows Server 2008 or above.
2. Pentium processor or above.
3. 512 megabytes of RAM.
4. 100 megabytes of free hard drive space for installation.
5. A thermal/Ink Jet/Laser printer with resolution at least 200 dpi. A laser printer with 600-dpi or above is

highly recommended.
6. A barcode scanner to verify the barcode created.

2.2. Installing Monterey Barcode Creator

2.2.1. To Install Barcode Creator from a CD
1. Insert the program CD into your CD drive. The setup starts automatically. Or if the auto-run feature

isn't enabled on your system, click the Windows Start button and choose the Run command. Type D:
\Setup.exe in the dialog box and click the OK button (Note that D represents the letter assigned to
your CD-ROM drive. If your drive is assigned to a different letter, use it instead of D).

2. Follow the on-screen instructions.
3. Your will be prompted to enter the License To/ Registration Code. The License to/ and

Registration Code information are found on the back of the CD case.

2.2.2. To Install Barcode Creator from direct download
1. Click the Download link to start the download.
2. When the browser prompts, do one of the following: A. To run setup immediately, click Open or Run

This Program from Its Current Location. B. If you decide to run the setup at a later time, click Save or
Save This Program to Disk.

3. If you choosed Save This Program to Disk in Step 2, locate the file where you saved it, and double
click the .exe file to run setup.

4. Follow the setup instructions.
5. Your will be prompted to enter the License To/ Registration Code. The License To/ and 

Registration Code information can be found in the email we send to you after order completes.

2.3. Running Monterey Barcode Creator
To run Barcode Creator, follow the basic operations:

1. Choose Programs from the Start menu.
2. Choose the Morovia folder.
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3. Choose Barcode Creator folder.
4. Choose the Barcode Creator 3.

The program can also be launched by double clicking the shortcut installed on the desktop.

2.4. The Workplace

2.4.1. Menu
Many program features of Monterey Barcode Creator, including the software menus, resemble to Microsoft
Office applications. They are easy to use.
A menu displays a list of commands. To select a command from the menus, you can do the following:

1. Click the left mouse button once directly on the menu name (i.e., File, Edit, View, etc.).
2. When the menu drops down, click once on the desired command.

2.4.2. Toolbar
The toolbar buttons give you quick access to many frequently used commands and features in the Monterey
Barcode Creator.
To find out the name of a tool, hold the mouse pointer motionless over the tool button for about a second and
a ScreenTip will appear showing the name of the tool.
The status bar at the bottom of the Barcode Creator application window also provides a brief description of
the tool, over which the mouse is positioned on.
To select a command using the toolbar, you may do the following:

1. Position the mouse over the desired tool button.
2. Click the left mouse button once.

2.4.2.1. Customizing Toolbars
You can rearrange or modify the toolbars, so that it is personalized for the way you work.
To show or hide a toolbar, on the drop-down View menu, point to toolbars, and then check the toolbars that
you want to show or hide. Alternatively you may right click on the spare space of the toolbuttons, then on the
pop-up menu check or uncheck the toolbars you want to show or hide.

The toolbars can also be moved anywhere on the screen by docking and floating.
To float and dock the toolbar, follow the steps below:

1. Double-click on the toolbar. Note that you must double-click on an area of the toolbar between or
below the toolbar buttons. The tools will now appear in a floating window.
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2. Click and drag the toolbar to the desired location. If you want the toolbar docked on the screen's edge,
drag the toolbar until the cursor appears over the edge. The cursor will change shape to indicate that
the toolbar can be docked.

3. To return a floating toolbar to its docked location, simply double click the title bar on the floating
toolbar's window.

2.4.3. Dialog
After you choose a command, a dialog often appears. A dialog is used to select options pertaining to the
command or feature. If an option in a dialog is dimmed, this means the option is not available. Some dialogs
provide various sets of options. These sets of options are divided into tabbed pages. Click on the tab to
display the options.

2.4.4. Properties Window
Monterey Barcode Creator 3 introduces a new window, which allows you to fine tune the barcode you
created.
Use this window to view and change the design-time properties of the barcode object located in the designer
window. Properties window is available from the View menu.
The Properties window displays different types of editing fields, depending on the needs of a particular
property. These edit fields include edit boxes, drop-down lists, and links to custom editor dialog boxes.
Properties shown in gray are read-only.

Element Graphic Description

Categorized Lists all properties and property values for the selected object,
by category. You can collapse a category to reduce the number of
visible properties. When you expand or collapse a category, you
see a plus (+) or minus (-) to the left of the category name.
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Element Graphic Description

Alphabetic Alphabetically sorts all properties and events for selected objects.
To edit an undimmed property, click in the cell to its right and
enter changes.

Properties Toggle on/off the display of the Properties window

Like toolbars, the Properties window can also be docked or floated.

2.5. A Quick Tour
Welcome to Monterey Barcode Creator, the powerful barcode image creation program. This quick tour is
designed to introduce you to the power and flexibility of the Monterey Barcode Creator. Monterey Barcode
Creator performs several key functions: creating, opening and printing barcodes. This short tour will show
you each of these functions.

After completing this tour, you should be able to perform all the tasks necessary to manage your barcodes.
The remainder of the manual is a reference for additional information about specific features.

In this tour we are going to make barcodes for our fictional product - Poly Report Cover. We'd like to print
the labels on a 2 X 7 Avery® label paper. Each label contains a UPC-A barcode with the bar height at 1.0 inch,
13 mils in X dimension. On the top of the barcode, we'd like to place the text Poly Report Cover TC-882. A
completed label will be the one like below:
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2.5.1. Creating Barcode
First, we are going to create a barcode. Start the Monterey Barcode Creator by clicking Start | Programs |
Morovia | Barcode Creator. The program displays a default barcode with Morovia encoded as a Code 39
barcode.

From the Symbology combo box in the Format toolbar, change the current symbology to UPC-A. The
program displays the default UPC-A barcode.

From the Message combo box in the Standard toolbox, type our sample number 03569012345, total 11 digits.
You do not need to enter the last checksum digit. If you do, the program ignores it. Press Enter or click the
Redraw button , which is on the right to the combo box.

The default barcode image does not have surrounding borders. To add the borders, select solid line from
the Border Style combo box located on the Border toolbar, and set the border width to 3/4 pt.

2.5.2. Changing Comment
The next step is to change the comment and place it on top. To do this, we need to open the Properties
window. Select View | Properties or click on the Properties button on the Standard toolbar.
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Click on the Comment edit box, select all the text and press Delete. Type Poly Report Cover\nTC-882. The
characters \n forces a line return at the middle of the text. Press Enter to apply the change.
Click on the ShowComment edit box and select True from the drop-down menu to show comment.
Click on the CommentOnTop box and select True to place the comment on top of the barcode.
Click on the CommentFont line. A small button appears at the right of the box. Click the button to pop up
the Font dialog. Change the typeface to Arial Black, set font style to regular and font size to 9 pt. If your
computer does not have the Arial Black typeface, use Arial instead.
Click OK to close the dialog box.
Click on the CommentAlignment box and select  mbxAlignCenter to place the comment in center.
Click on the BarHeight box and enter 1000. All length units in Barcode Creator are in mils (1/1000th inch); so
1000 translates to 1.0 inch, which is what we wanted.
You can also enter the bar height through the BarHeight combo box appearing on the Standard toolbar. In the
combo box you can use text form of the length, such as 1.0 inch.
Navigate to the NarrowBarWidth and enter 13. As indicated above, 13 means 13 mils or 0.013 inch.

2.5.3. Adjusting Symbol Margins
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We want to leave enough spaces between the barcode and the borders. This can be done by adjusting
comment margin properties. Scroll down the Properties window and locate four symbol margin
properties: CommentMarginTop, CommentMarginBottom, CommentMarginLeft and CommentMarginRight.
Assign 100 to CommentMarginTop and CommentMarginBottom. Assign 300 to CommentMarginLeft and
CommentMarginRight. All length units used in Barcode Creator are in mils (1/1000th inch). So 300 translates
into 0.3 inch.

2.5.4. Saving the File
To save the file, press Ctrl+S or select Save from the File menu. Type the file name you would like to use and
click OK.

2.5.5. Printing Barcode Labels
After we finished the barcode design, now we can print them out. Our goal is simple: print a full sheet of
barcode labels on Avery 8463 label paper. To do this, we first load the label paper in our printer. If you do not
have such a label paper, simply load the standard letter or A4 paper.

Select Print from the File menu, or press the Print button on the Standard toolbar. The Print dialog pops up.

Check Use Label Settings box. The dialog expands to display the label paper properties.

In the Label Products combo box, select Avery Standard. In the Product Number box, scroll all the way
down and select 8463 - Shipping.

In the Print Range box, make sure that Full Page of the Same Label option is selected.

You can have the program remember the label settings by clicking the Save button. Next time, the program
loads the label settings automatically.

Click on the Print button to print a full sheet of barcode labels.

Started from version 3.3, Barcode Creator supports some advanced features such as batch printing. For more
information, refer to Chapter 5, Printing Barcodes.

2.5.6. Making the default template
If you want to re-use the properties of this barcode file (such as comment text and margins), you can make
the file as a template for your future new barcode files. After you make the file a template, all subsequent new
barcodes copy the properties from this template file. If the template file is not present, the default barcode
properties are used.

To make a file template, click on Tools | Options to pop up the Options dialog. Click the Browse button at
the right of Template File to Use box and navigate to the barcode file we just created. Click OK twice to
dismiss the dialogs.

Now select New from the File menu. The new barcode copies all the properties from the template file.

2.6. Thumbnail View in Windows Explorer
Thumbnail view shell extension is available since version 3.6 (released in July 2010). When thumbnail view
is enabled in Windows Explorer, you can view the contents of the files in thumbnail in Windows Explorer,
without opening Barcode Creator.
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Figure 2.1. Thumbnail View in Windows Explorer

In version 4, 64-bit thumbnail view shell extension is added to package.



Chapter 3. Menu Commands

3.1. File Menu
The commands on the File menu allow you to create, save, close, print, export barcode files and exit Monterey
Barcode Creator itself.

Figure 3.1. File Menu

• New
A new barcode drawing is created by using the New command on the File menu. When a new barcode
drawing is created and displayed on the screen, the default properties are copied from a template file.
You can specify the template file from Tools | Options menu. If no template file is present, the default
settings are used. The default barcode drawing bears Morovia logo and copyright.

• Open...
A saved barcode file can be redisplayed by using the Open command on the File menu.
A standard Windows File Open dialog pops up to allow you to explore the file system to locate the
barcode file you want to open.

• Save/Save As
When you open a barcode drawing, Monterey Barcode Creator loads the contents from the disk to the
screen. Changes made to the barcode drawing are temporarily stored in memory until you save them to
the disk.
Barcode drawings are saved with Save or Save As command on the File menu.
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If you use the Save command to save the barcode document and the selected barcode document is
unnamed, the Save dialog will appear prompting you to provide a name. If you attempt to close the
file to which you have made changes, you will be asked if you want to save the drawing. You can save
the barcode file to any folder you want. In practice, we recommend you use a dedicated foler under My
Documents folder and under the root disk drive.

We also recommend that you save your drawing often when making extensive changes, so that you
avoid losing your work due to power outages or other unplanned events.

• Export Image...

After you finish designing your barcode, you may desire to move the artwork to another program.

Monterey Barcode Creator supports the following graphics format: BMP, JPEG, GIF, TIF, PNG and
EMF. The EMF (enhanced metafile) is a vector graphics format and used internally by Windows. All
others are raster graphics formats.

If you export an image in a raster graphics format, such as JPEG, you need to be aware that raster
image format does not hold all information, especially under a low resolution condition. A raster image
can be though as a two-dimensional array of pixels, with each pixel containing the color information.
Most of raster image formats do not have a field to specify the resolution information. As a result, you
may need to specify the resolution when you export to another program.

The property of RasterImageResolution determines the resolution used when exporting to a raster
image format. The default value of this property is 300.

• Print...

Monterey Barcode Creator has a built-in database with 1,500 known label paper products. Most likely
the label paper you are using is already in the database; if it is not, you can always add it.

Click the Use Label Settings... button to activate the label paper list. Select the paper you are working
with and check the appropriate printing options. Otherwise the barcode is printed on the top left side
of the paper.

• Print Preview

To see how a barcode drawing will appear when printed, use the Print Preview command on the File
menu or click the Print Preview button on the toolbar. Print Preview will show you an exact replica of
the printed chart on your computer screen. The Print Preview command is also available directly from
the Print dialog.

The buttons along the top of the Print Preview window allow you to print and change the view of the
chart.

• Print Setup

To select the default printer, paper size, use this command.
• Recent Used Files

The four most recently opened or closed barcode files are displayed at the bottom of the File menu.

To open one, you can either click it with the mouse, highlight it and press ENTER, or choose the
number (with the File menu displayed) that corresponds to the one you want to open.

3.2. Edit Menu
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Figure 3.2. Edit Menu

• Copy
The copy command allows you to transfer the graphics to Windows clipboard. The format used is
Enhanced Windows Metafile, a format which records the frame size. Most of Windows graphics
programs support this format.
Although Windows Metafile is a vector format, many programs rasterize the drawing using the screen
resolution. It may cause printing problems. If this is the case, save the file as Bitmap at a high resolution
(ex. 300 dpi) and import the file into the graphics program.

• Undo
The Undo command has the effect of undoing the last document property modification. If nothing can
be undone, it displays in grey.

• Redo
The Redo command reverses the last Undo operation.

3.3. View Menu
Figure 3.3. View Menu

The commands on the View menu toggle the Toolbars and Status Bar on and off.
• Toolbars

The toolbars are found below the menu bar ot the top of the screen. Each of the button on the toolbars
represents a frequently used command in the Barcode Creator. See Chapter 1 for detailed information
about using the toolbars.
Monterey Barcode Creator V3.0 features three toolbars: Standard, Format and Border.
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• Status Bar

The Status Bar is at the bottom of the Barcode Creator application window. It provides a description
of the currently selected menu command in the first pane. The next 3 panes on the right provide
information about the current symbology, overall symbol size and the current zoom ratio.

To display the Status Bar

Choose the Status Bar from the View menu, so that a check mark appears.

To hide the Status Bar

Choose the Status Bar from the View menu, so that the check mark disappears.

View the current symbology

The current symbology information is found at the second pane of the Status bar.

View the overall symbol size

The symbol size is expressed in inch. It is located at the third pane of the Status bar.

View the zoom ratio

The zoom ratio information is located at the last pane of the Status bar.
• Properties

This command toggles the display of the Properties Window.

Monterey Barcode Creator 3 introduces a new window allowing you to fine control the barcode you
created.

Use this window to view and change the design-time properties of the barcode object located in the
designer window. Properties window is available from the View menu.

The Properties window displays different types of editing fields, depending on the needs of a
particular property. These edit fields include edit boxes, drop-down lists, and links to custom editor
dialog boxes. Properties shown in gray are read-only.

• Zoom In / Zoom Out / Actual Size

The Zoom In and Zoom Out commands can be selected from the View menu or from the Standard
toolbar. The Zoom Ratio is displayed in the Status bar.

The Zoom In command progressively zooms in on barcode drawing displayed on the screen. Each time
the command is used, the more detailed the view of the barcode drawing.

The Zoom Out command changes the scaling to the previously zoomed state. For example, if you have
used the Zoom In command to zoom in on the drawing four times, the Zoom Out command will take
you back to the third zoomed view. Using it again will take you back to the second zoomed view, etc.

• Rotate Left / Rotate Right

The Rotate Left and Rotate Right commands are selected from the View menu.
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The Rotate Left command rotates the barcode drawing anti-clockwise in an increase of 90 degrees.
The Rotate Right command rotates the barcode drawing clockwise in an increase of 90 degrees.

3.4. Tools Menu

Figure 3.4. Tools Menu

The Options... command on the Tools menu allows you to configure the template file. It also lets you display
or hide the Properties window.

• Options

The Options dialog is used to configure the default template file to use when creating a new barcode. It
also gives you options to configure the display attributes of the Properties window.
• Template File to Use. Specify the template to use when creating a new barcode. All the properties

of the template barcode are copied to the new barcode. This allows you to create multiple barcodes
based on a common property set.
For example, you want to create 100 barcodes, each with a different number but all have the same
comment and layout. You can create a barcode and save it into the disk. Then open the Options
dialog and navigate to this file. After that all the new barcodes generated will have the same
comment and layout.

• Show Properties window at startup. Select this option to display the Properties window at the
startup. The Properties window is hidden by default.

• Float Properties window at startup. Select this option to make the Properties window float at
the startup. Note that you must check the Show Properties window at startup too to display the
Properties window.

3.5. Window Menu
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The commands on the Window menu are used to control the layout of the drawings and icons in the Barcode
Creator workspace. All commands are standard MDI (Multiple Document Interface) commands. For more
information, visit http://msdn2.microsoft.com/en-us/library/ms644908.aspx.

Figure 3.5. Window Menu

• New Window

Use the New Window command to create a new window of the current document. This feature is
useful when you want to have different views present. For example, you can have a window showing
100% zoom ration and another one at 400%.

• Cascade

Use the Cascade command to arrange all open windows in a cascade-like arrangment in the Barcode
Creator workspace

http://msdn2.microsoft.com/en-us/library/ms644908.aspx
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• Tile

Use the Tile command to arrange all open windows in a title like arrangement in the Barcode Creator
workspace.
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• Arrange Icons

Use the Arrange Icons command to arrange all document icons at the bottom of the Barcode Creator
workspace. A document is minimized by clicking on the minimize button on the top right corner of the
window frame.

• Document List

At the bottom of the Window menu, the names of each open document are listed. A check mark
designates the currently selected document.

To switch between documents using the Window menu, click on the name of desired document. You
can also switch between documents by simply clicking directly on the desired document in the Barcode
Creator workspace. The selected document has a unique heading background.

• More Windows...

The last menu item is More Windows command, which pops up a dialog allowing you to activate, save,
close or minimize any open window.
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3.6. Help Menu
The quickest way to find out how a specific feature works in Barcode Creator is using the help system. The
Barcode Creator's help system can be accessed by choosing Barcode Creator Help from Help menu.
The Monterey Barcode Creator User's Manual and the Help are based on the same material.

Figure 3.6. Window Menu

• Help Topics
Use Help Topics command to view the online help. The help is in standard Microsoft HtmlHelp format.
You can search by keywords, or read it topic by topic.

• Morovia Web Site
Use this command to quickly access Morovia web site.

• About...
The About command displays a window with information about your copy of the Monterey Barcode
Creator, including the program version, build number, license to and registration code.
If you are using a trial version of the Monterey Barcode Creator, a register button displays. Press this
button to pop up the registration dialog, from which you can type the registration information to
convert your trial copy to the retail version.
Both LicenseTo and Registration code must match the ones appeared in the email we sent to you
if you order online at Morovia WebStore1 or our affiliate shopping sites. Both fields must match. The

http://store.morovia.com
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registration information is written to the registry and checked every time you start the Monterey
Barcode Creator.

Note Entering registrion information requires the current user having
administrator privilege. If you are not a member of local administrators, you need to
log on as an administrator to reigster the software.



Chapter 4. Toolbars
Monterey Barcode Creator features three toolsbars: the Standard toolbar, the Format toolbar and the Border
toolbar. A toolbar comprises various buttons and other controls, which allow you to quickly access a
command.

4.1. Standard Toolbar
On the View | Toolbars menu, you can specify whether or not you want to display the Standard Toolbar. The
Standard Toolbar includes following tool buttons.

Figure 4.1. Standard Toolbar

• New. Create a new barcode drawing. Same as File | New.
• Open. Open an existing barcode file. Same as File | Open.
• Save. Save the current drawing into a disk file. Same as File | Save.
• Copy. Copy the current drawing onto clipboard, so that it can be pasted into another program. Same as

Edit | Copy.
• Undo. Undo the last action. Same as Edit | Undo.
• Redo. Revert the last Undo operation. Same as Edit | Redo.
• Zoom In. Scale up the current drawing. Same as View | Zoom In.
• Actual Size. Restore the scale ratio to reflect the actual size of the drawing. Same as View | Actual Size.
• Zoom Out. Scale down the current drawing. Same as View | Zoom out
• Message. Enter text into this combo box to change the Message property of the barcode object.
• Redraw. Redraw the current drawing.
• BarHeight. Through this combo box you can change the BarHeight property of the barcode. Monterey

Barcode Creator allows some flexibility on the input, such as 0.5 in, 3cm etc.
• Properties Window. Use this button to toggle the display of Properties window.
• Print. Displays the Print dialog to print the barcode drawing. Same as File | Print.
• About. Displays the About dialog. Same as Help | About.

4.2. Format Toolbar
Format Toolbar provides commands to change the symbology, control the foreground and background colors
of the image, as well as the typeface and alignment options of the human readable.
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Figure 4.2. Format Toolbar

• Human Readable Typeface. This combo box allows you to quickly change the typeface used in the
human readable. The font combo box provides a preview of each font.

• Symbology. The symbology combo box allows you to change the barcode format used. It displays the
full list of symbologies supported by this program.

• Alignment. The next four buttons control how the human readable text is aligned. You can align the
text to the left, to the right, to the center or justification the text.

• ForeColor and BackColor. Use the two buttons to select the forecolor and the backcolor of the image.
Note: barcodes require decent contrast ratio in order to be read succesfully. Always test the results
thoroughly when you select a color pair instead of black and white.

4.3. Border Toolbar
Border Toolbar provides commands to select border style, size and color. It also has three check boxes
allowing you to toggle the display of the human readable text, comment; and contorl if the text is placed on
the top of the barcode image.

Figure 4.3. Border Toolbar

• Border Style. The Border Style offers a list of border styles, including solid line, dot line, solid dot dot
line and so on.

• Border Width. Defines the width of the border.
• Border Color. You can select the border color from the color picker dialog.
• Human Readable. Toggle the display of the human readable text.
• Comment. Toggle the display of the comment.
• Text On Top. If the check box is selected, the haman readable text is placed on the top of the barcode

image; otherwise it is at the bottom. Not all symbologies honor this setting.



Chapter 5. Printing Barcodes
Montrey Barcode Creator allows flexible printing options. Having a built-in database with 1,500 label paper
templates, it supports label printing. If you can not find the label paper you are using, you can always add
your own. Started from version 3.3, Monterey Barcode Creator supports batch printing, which lets you
specify a number sequence or a data file, from where the program pulls a series of data and print their
barcode representations in one command.
All printing capabities are accessible from the Print dialog.

5.1. Print Dialog
The Print command under the File menu activates the Print dialog. You can use this dialog to control the
print range, to batch print series of barcodes, to define you own label papers, or set other options.

Figure 5.1. Print Dialog

• Printer
The current selected printer is shown at the top of the dialog. You can change to a different printer by
clicking the Setup... button.
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• Print Quality

Displays the printer resolution. To change to a different resolution, use the drop down list (if the
printer supports multiple resolutions).

• Printing Multiple Copies

You can print more than one copy of your barcode image by entering the number of copies you want in
the Copies field. The Collate Copies check box determines the order in which the copies of the drawing
are printed.

• Use Label Settings

Check this box if you want to print on label papers. Uncheck this box if you want to print to a plain
paper. The dialog expands or collapses based on the status of this option. If you choose to use label
settings, you will have to configure the settings.

• Save

Save the current label settings as the default. The Print dialog will switch to the label you specified last
time, and the print preview will use this label settings. If you frequently print to a specific label paper,
select the label paper first and click Save.

• Cancel

Click the Cancel button to cancel the print operation.
• OK

Click the OK button to print the current barcode image.
• Print Range

You can define two types of print ranges. Select the first option to print a full page of the same label.
Select the second option to print a single label. For example, if you want to print the barcode on the
second row and the third column of the label paper, select Single Label button, and type 2 in the Row
edit box and type 3 in the Col edit box.

• Label Products

This drop-down box displays the label paper vendors in database. Choose the one matches your paper,
or use Other/Custom to add one which does not exist in the database.

• Product Number

This field displays all products made by the selected label paper vendor. In the box on right side, the
information about the current selected label product will be displayed.

• Label Information

Displays the type, height, width and paper size of the label product you selected.
• Details

Clicking this button pops up the Details dialog. It displays the product name, label width, label height,
horizontal pitch and vertical pitch.

5.2. Batch Printing
Version 3.3 adds powerful batch printing functionality, which allows users to specify a number sequence or a
data file as the data source.

To set up the data source, click on the Batch Setup... button on Print dialog.

The Batch Setup dialog provides two operating modes: Number Sequence and Data File.
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Figure 5.2. Batch Setup Dialog

5.2.1. Number Sequence
Number Sequence allows you to define a series of data started from Initial Value, incremented or
decremented by a specified value within a character set specified. A simple example is to print barcodes with
data 000 ~ 999 encoded (total 1,000 labels). You can specify the sequence as:

• Type: Increment
• Character Set: Numeric Only
• By Value: 1
• Intial Value: 000
• Number of Runs: 1000

5.2.1.1. Number Wrap
The number sequence algorithm assumes that the number created has fixed length (which is implicit through
the Intial Value. If you specify 000 as the intial value, all numbers generated will be fixed with 3 digits.
The significant digit rolls back to zero when the value goes beyond the maximum value. For example, if you
specify the Number of Runs as 1001, the last run will go back to 000, instead of 1000. This is called Number
Wrap. For this reason, always make sure that you put enough leading zeros in the intial value.

5.2.1.2. Options
Number Sequence dialog supports the following options:

Type
Allows you to specify the movement direction of the alogorithm: Increment or Decrement.
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Character Set
This function allows you to specify the character set combination. Monterey Barcode Creator supports the
following combinations:
• Numeric Only. This is the default option. The algorithm operates on an integer counter. For exmaple:

000, 003, 006, 009, 012...
• Uppercase Alphanumeric. This character set includes all digits and all upper case letters, with upper case

letters at higher position. Example: AA9, AAA, AAB, AAC, AAD...
• Upperscase Alpha. This character set includes all upper case letters only. Example: AAX, AAY, AAZ,

ABA, ABB...
• Hexadecimal. The algorithm operates on a hexadecimal counter. For example: 009, 00A, 00B, 00C...
• Custom. It indicates that you are supplying your own character set (in the Custom Set box).

Custom Set
If you choose a custom set, you must enter the allowable characters in this set. Note that the order of
characters is also important. For example, 0123ABCD is a different custom set from 0A1B2C3D. In the
former case, 333 becomes 33A after being incremented by 1. In the latter case, the result is 33D.
For example, suppose that your order number is uppercase alphanumeric and does not contain characters
O (to be confused with digit 0), I (to be confused with 1) and Q. Selet Custom in the Character Set box,
and fill the Custom Set with the value below:
0123456789ABCDEFGHJKLMNPRSTUVWXYZ

By Value
Sets the interval by which the number increments or decrements.

Intial Value
Sets the value for the first label in the series.

Number of Runs
Sets the number of runs after which the printing stops.

5.2.2. Data File
Data File allows you to specify a comma separated file (.csv) and the column from which the data is taken.
File Path

The path of the file.
Column

The column number, or the name of the column.



Chapter 6. Using Barcode Creator in MS
Word, Excel and other programs
Monterey Barcode Creator can exchange drawings with other Windows programs. It is specially designed to
work closely with Microsoft Office programs, such as Word™ Excel™ and PowerPoint™.

6.1. Inserting Drawings into Microsoft Office Prorams
You can use the methods below to transfer barcode drawings into Microsoft Office programs. We use Word as
an example, but you can apply to other programs as well.

• Copy and Paste

The easist way to transfer drawings you created in Barcode Creator is to simply Copy the drawing
in Barcode Creator. Select the Copy command under the Edit menu, or click the edit button on the
Standard toolbar, follow by pasting it in Microsoft Word (or other programs).

• Using the Insert command

You don't have to actually run Barcode Creator at all, in order to insert a Barcode Creator drawing
into a Word document. Word has an Insert Object... command on its Insert menu. You can use this
command to insert a Barcode Creator drawing directly into your Word document.

When you use the Word Insert command, Word automatically launches Barcode Creator, so that you
can select, modify, or create the drawing you want to insert.

When you insert a new drawing, the template is used to create a barcode.
• Drag and Drop

You can also drag selected parts of a drawing from Barcode Creator into Word, Powerpoint or other
Office programs.

6.2. Understanding OLE (Object Linking and Embedding)
Because Word (Excel, Powerpoint etc.) is an OLE client and Barcode Creator is an OLE server, Word stores
all the drawing information in its document when you paste it, not just the picture you see. This is called
Embedding. All properties of the drawing are embedded in Word document, and you can revisit the drawing
later on.

If you double-click on the Barcode drawing in Word, it will launch Barcode Creator and you can edit it
through Barcode Creator.

Using embedding approach, it increases the size of the Word document. When there are many barcodes in
a single document, it slows down the program. An alternative way is to paste the link only, through Word's
paste special command.
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Figure 6.1. Paste Object Link

When you double-click on the linked Barcode Creator drawing in Word, it opens the original Barcode Creator
file, allowing you to edit it. OLE linking is useful if you want a drawing shared by multiple documents. It
also reduces the document size. Changing the one linked drawing changes all the linked copies of the same
drawing.

6.3. Inserting Object with the Insert Command
You can also add barcodes into your documents with the Insert Object command from the Edit menu in
Word.

Figure 6.2. Insert Object Dialog (I)



CHAPTER 6    USING BARCODE CREATOR IN MS WORD, EXCEL AND
OTHER PROGRAMS        29

Figure 6.3. Insert Object Dialog (II)

Link to file option allows you to place a link to a physical file, instead of copying the contents into the Word
program.

6.4. Managing OLE Object Links
When an OLE linked object is selected, the Links command under the Edit menu will activate the Link dialog.
You can use this dialog to manage OLE links in your document.

Figure 6.4. Link Dialog





Chapter 7. Barcode Properties Reference
In this chapter, you will find detailed information about each barcode object property. Some properties may
not be modified under certain design mode. Some properties may be related to other properties - i.e. change
to one property will change other properties. For example, changing Symbology property will also alter the
value of Message property.

7.1. List of Properties

Table 7.1. List of Barcode Object Properties

BackColor Specifies the background color for the control.

BarHeight Specifies the height of the bars in the control, in user units.

BearerBars Determines whether to include the bearer bars around the barcodes.
Applicable on selected symbologies.

BorderColor Specifies the border color.

BorderStyle Specifies the border style.

BorderWidth Specifies the border width, in logical units.

Code25OptionalCheckDigit Determines whether to include an optional checksum digit in all Code25
barcodes.

Code39OptionalCheckDigit Determines whether to include an optional checksum digit in all Code 39
barcodes.

Code39StartStopChars Determines whether to display the start and stop characters in the human
readable of all code 39 barcodes.

Comment Specifies the text string for the human readable comment printed around the
barcode.

CommentAlignment Determines how the comment are aligned.

CommentFont Specifies the font used to draw comment text.

CommentMarginBottom Specifies the margin on the bottom of the comment box.

CommentMarginLeft Specifies the margin on the left of the comment box.

CommentMarginRight Specifies the margin on the right of the comment box.

CommentMarginTop Specifies the margin on the top of the comment box.

CommentOnTop Determines whether the comment box is placed above the barcode image.

Font Specifies the font used to draw human readable text.

ForeColor Specifies the foreground color of the control.

I2of5OptionalCheckDigit Deprecated in version 3.6.

Message Specifies a string which represents the data to be encoded.

NarrowBarWidth Specifies the width of the narrowest module in linear symbologies.
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NarrowToWideRatio Specifies the ratio used to calculate the width of the wide element.
Applicable on selected symbologies.

QuietZones Determines whether to include quiet zones in the barcodes.

RasterImageResolution Specifies the resolution which is used to export raster images.

Rotation Specifies the rotation direction and degrees.

ShowCheckDigit Determines whether to include the checksum character in the human
readable.

ShowComment Determines whether the control displays the comment element.

ShowHRText Determines whether to display the human readable text.

SymbolMarginBottom Specifies the margin on the bottom of the symbol.

SymbolMarginLeft Specifies the margin on the left of the symbol.

SymbolMarginRight Specifies the margin on the right of the symbol.

SymbolMarginTop Specifies the margin on the top of the symbol.

Symbology Specifies the barcode format (symbology).

TexAlignment Specifies how the human readable text is aligned.

TextOnTop Determines whether the human readable text is placed above the barcode
image.

UccEanOptionalCheckDigit Deprecated in version 3.6
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7.2. BackColor, ForeColor Properties

Description
BackColor - returns or sets the background color of the control.
ForeColor - returns or sets the foreground color of the control.

Remarks
For opening systems, we strongly recommend to set the background color to solid white (0xFFFFFF) and
foreground color to black (0x000000). Note: barcode requires decent contrast between the foreground color
and the background color, in order to be readable. Always test the readability thoroughly when you select a
color pair different from black and white.
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7.3. BarHeight Property

Description
Returns or sets a value for the height of bars in barcode control.

Remarks
The BarHeight property specifies the height of the dark elements in all linear symbologies with exception
(see notes below). The actual value is affected by the Measurement property. If Measurement is set to
mbxMeasureEnglish, the unit for this property is mils (1/1000 inch), otherwise it is 1/1000 cm. The default
value is 1000 which translates to 1 inch or 1 cm, depending on the measurement unit specified.
This property have no effect on the size of two-dimensional barcodes, such as PDF417, DataMatrix and
MaxiCode.
The height of elements in postal symbologies (POSTNET and RoyalMail) is fixed. Therefore, changing this
property has no effect on those types of barcodes.
The height of bars in a DataBar Truncated symbol is fixed at 13X (X is the industry term for NarrowBarWidth),
and the height of a DataBar Stacked symbol is fixed at 50X. Therefore, this property does not affect the height
of those two types of symbols.
In stacked symbologies (DataBar Stacked Omnidirectional and DataBar Expanded (multi-row), the overall height
is the number of rows multiplying BarHeight, plus the height of any required separator rows.
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7.4. BearerBars Property

Description
Returns or sets a value that determines whether to include bearer bars around the barcode.

Remarks
Bearer bars (see below) are horizontal bars printed across the top and bottom of the barcode image. Bearer
bars can help to avoid partial reading, should the reader move off the top or bottom of the code. Only certain
symbologies require bearer bars (for example Interleaved 2 of 5), because the start and stop characters in most
barcodes make bearer bars unnecessary.
In Barcode Creator, the following symbologies can have bearer bars: Codabar, Code11, Code25, Code128, UCC/
EAN-128, Code39, Code39 HIBC, Code 39 Full ASCII, Code93, Interleaved 2 of 5, MSI/Plessey and Telepen. Other
symbologies ignore this property.



36        CHAPTER 7    BARCODE PROPERTIES REFERENCE

7.5. BorderColor Property

Description
Returns or sets the color of borders.

Remarks
Use this property to specify the border color. The default value is 0 (black).

See Also
Section 7.7, “BorderWidth Property”
Section 7.6, “BorderStyle Property”
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7.6. BorderStyle Property

Description
Returns or sets a value that determines the border style.

Remarks
Use BorderStyle property to specify the border style. This property is set by using one of the BorderStyle
enumeration values:

Table 7.2. Border Styles

Constant Value Description

mbxBorderStyleNone 0 No border lines

mbxBorderStyleSolid 1 Solid line

mbxBorderStyleDash 2 Dash line

mbxBorderStyleDot 3 Dot line

mbxBorderStyleDashDot 4 Dash dot line

mbxBorderStyleDashDotDot 5 Dash dot dot line

See Also
Section 7.5, “BorderColor Property”
Section 7.7, “BorderWidth Property”
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7.7. BorderWidth Property

Description
Returns or sets the value for border width.

Remarks
Use BorderWidth property to specify a border width. The border width is expressed in logical units
prescribed by the Measurement property. For example, if you set this property to 15 and the Measurement is
mbxMeasureEnglish, the border width is 15 mils (0.015 inch). The default value is 15.
To disable the border, set BorderWidth to 0 or BorderStyle to mbxBorderStyleNone.

See Also
Section 7.6, “BorderStyle Property”
Section 7.5, “BorderColor Property”
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7.8.  Code25OptionalCheckDigit Property

Description
Returns or sets a value that determines whether to include an optional checksum digit in all Code25 barcodes
produced by Barcode Creator.

Remarks
A code 2 of 5 barcode can have an optional check digit. When the Code25OptionalCheckDigit is TRUE,
a check digit is calculated using modulo 10 algorithm and added to a code 2 of 5 barcode. To display the
checksum digit in the human readable text, set ShowCheckDigit to TRUE.

See Also
Section 8.7, “MSI/Plessey, Code 25 and Code11”
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7.9. Code39OptionalCheckDigit Property

Description
Returns or sets a value that determines whether to include an optional checksum digit in all Code39 barcodes
produced by Barcode Creator.

Remarks
A code 3 of 9 symbol can have an optional check digit (character) at the end of the barcode. When the
Code39OptionalCheckDigit property is set to TRUE, a check digit is calculated using modulo 43 method and
appended to the end of the barcode. To display the checksum digit, set ShowCheckDigit to TRUE.
This property affects two symbologies: Code 39 and Code39 Full ASCII.

See Also
Section 8.2, “Code 39”
Section 8.3, “Code 39 Full ASCII”
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7.10. Code39StartStopChars Property

Description
Returns or sets a value that determines whether to display the start and stop characters in the human
readable text in all Code39 barcodes produced by Barcode Creator.

Remarks
For historical reasons, many code39 symbols print start/stop characters (asterisks) at the beginning and the
end of the human readable text. While the start and stop characters are always present in the barcode, it is not
necessary for them to appear in the human readable. When the Code39StartStopChars property is set to TRUE,
the asterisks are displayed at both the beginning and end of the human readable.
This property affects the three Code39 symbologies - Code 39, HIBC and Code39 Full ASCII.

Note  The asterisks are not part of the encoded data. You should not include
asterisks in Message property when creating Code39 barcodes.

See Also
Section 8.2, “Code 39”
Section 8.4, “Code 39 HIBC”
Section 8.3, “Code 39 Full ASCII”
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7.11. Comment Property

Description
Returns or sets a string for the comment to be printed around the barcode symbol.

Remarks
In addition to the human readable, which always reflects the encoded data and conforms to the standard
requirements, you can optionally place a paragraph of text beside the barcode image.
You may adjust margins around the comment, place the comment on the top or bottom, modify the font
typeface as well as the size, and change how the text is aligned.
Control characters are not printed.

Note  It is now possible to enter multiple paragraphs in the comment by inserting
\n at the end of each paragraph (except the last one). For example, the string First
paragraph\nSecond Paragraph renders two paragraphs, as illustrated below:

See Also
Section 7.13, “CommentFont Property”
Section 7.12, “CommentAlignment Property”
Section 7.25, “ShowComment Property”
Section 7.15, “CommentOnTop Property”
Section 7.14, “CommentMarginTop, CommentMarginBottom, CommentMarginLeft, CommentMarginRight
Properties”
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7.12. CommentAlignment Property

Description
Returns or sets a value indicating how the comment is aligned.

Remarks
This property controls how the text in the comment portion is aligned. Valid alignment choices are listed in
the table below:

Table 7.3. CommentAlignment Options

Constant Value Description

mbxAlignLeft 0 Left alignment (default). Align the text to the left edge of the comment
box.

mbxAlignRight 1 Right alignment. Align the text to the right edge of the comment box.

mbxAlignCenter 2 Center alignment. Align the text to the center of the comment box.

mbxAlignJustify 3 Justify alignment. Align the text to both edge of the comment box.
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7.13. CommentFont Property

Description
Returns or sets the font for comment text.

Remarks
The default font used to draw comment text is typeface of Arial, 8 points.
This property is used to retrieve/set the font used for comment text. To set/retrieve the font used for human
readable text, use Font property.
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7.14. CommentMarginTop, CommentMarginBottom,
CommentMarginLeft, CommentMarginRight Properties

Description
These four properties control the margins around the comment box.

Remarks
The above four parameters control the margins around the comment text box.
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7.15. CommentOnTop Property

Description
Returns or sets a value that determines whether the comment box is placed above or below the symbol.

Remarks
The default value for CommentOnTop is FALSE. To place the comment on top of the image, set this property
to TRUE.
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7.16. Font Property

Description
Returns or sets the font for human readable text.

Remarks
The default font used to draw human readable text is typeface of Arial, 9 points. Generally speaking, you
should use a sans-serif font for human readable text. Some industries require OCR-B(Optical Character
Recognition Revision B) font to be used.
This property is used to retrieve/set font for human readable text. To set /retrieve font used for comment, use
CommentFont property.

See Also
Section 7.26, “ShowHRText Property”
Section 7.29, “TexAlignment Property”
Section 7.30, “TextOnTop Property”



48        CHAPTER 7    BARCODE PROPERTIES REFERENCE

7.17. I2of5OptionalCheckDigit Property

Description
Deprected since 3.6.

Remarks
Previously, in order to add check digit to an Interleaved 2 of 5 bracode, you need to set this property to TRUE.
Interleaved 2 of 5 symbology requires the input to be even length. If this property is TRUE and the input
already has even length, the previous implement appends a '0' at the end, and calculate the check digit. This is
an unexected behavior for many customers.
In version 3.6 and above, this property has no effect on the barcode created. Whether or not a check digit is
required depends on if the length of the input is even or odd. If the length is even, no check digit is added
and Barcode Creator encodes as is. If the length is odd, however, the program calculates the check digit and
automatically appends at the end to make the whole length even.

See Also
Section 8.13, “Interleaved 2 of 5 (ITF25)”
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7.18. Message Property

Description
Returns or sets a string for the message to be encoded.

Remarks
Not all symbologies are capable of encoding all characters. Some may only encode numeric data. Some
impose a limit on the length of the encoded data. If you encode data with invalid characters or length,
Barcode Creator returns an error.

• UPC symbologies (UPC-A, UPC-E, EAN-13, EAN-8)
A UPC symbol may have an optional 2-digit or 5-digit add-on barcode. To create an add-on
barcode, separate the main data and the extension data with a vertical bar. For example, the input
1-932111-39-5|55999 produces a Bookland barcode with a 5-digit add-on symbol.

• GS1-128 symbology
To ensure the human readable format is correct, the AI and field ID must be enclosed with parentheses
( () ). If the data is formatted incorrectly, you may end with an error. For example, the following data is
valid for UCC/EAN 128 message input:
(01)12345678901231

Additional information is also needed to create a shortest possible barcode. Refer to Section 8.12,
“UCC/EAN-128” for more details.

• Tilde codes
Tilde code sequence can be used to enter special characters, such as extended ASCII characters and
symbology-specific characters if supported. See each Symbology section for details.
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7.19. NarrowBarWidth Property

Description
Returns or sets a value for the width of the narrowest module in linear symbologies.

Remarks
This property defines the width of the narrowest element in a linear barcode - a.k.a X-dimension. The
measurement unit is in either 1/1000 inch or 1/1000 cm depending on the Measurement unit used.
By default the value for this property is 13. The valid range is from 1 to 1000. Industry standards require that
the barcodes used in an open system have a X-dimension at least of 10 mils (one-hundredth of inch). If the X-
dimension is too small, some scanners may have problems reading the barcode.
This property affects most linear symbologies. Height-modulated postal barcodes, such as POSTNET and
Royal Mail barcodes, use fixed pitch; thus this property has no effect on these symbologies.
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7.20. NarrowToWideRatio Property

Description
Returns or sets the ratio of the wide to narrow bar in a barcode.

Remarks
Some linear symbologies can have two module widths. The width of the wide one is a fixed multiple of the
width of the narrow module (NarrowBarWidth). You can choose a value ranging from 2.0 to 3.0 for this ratio.
This property is valid only for Code 39, Code 25, Code 11, Codabar and Interleaved 2 of 5 symbologies. All
others ignore this property. We also recommend you set a value between 2.5 to 3.0, so the barcode can be
easier to be recognized.
Since the value may impact the readability of the barcode, we highly recommend that you test the barcode
readability when you set the value to anything below 2.5.
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7.21. QuietZones Property

Description
Returns or sets a value that determines whether to include quiet zones on the barcodes generated.

Remarks
For linear barcodes, quiet zone is defined as a clear space that precedes the start character of a barcode symbol
or follows the stop character. For two-dimensional barcodes, quiet zones are clear area around the barcode.
The spaces are required to help scanner determine where the barcode starts and stops.
The width of space added is 10 times the NarrowBarWidth value for all linear barcodes, 2 times
PDFModuleWidth value for PDF417 barcodes, 2 times DataMatrixModuleSize value for DataMatrix barcodes
and 1 element width for MaxiCode barcodes. Setting this property to TURE, substantially increase the barcode
length for linear symbologies.
You can also use symbol margins to create effective quiet zones. By default Barcode Creator set the symbol
margins to 100 mils at 4 directions. When this is the case, you may safely set this property to FALSE to better
align the comment and human readable text.
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7.22. RasterImageResolution Property

Description
Returns or sets a value that corresponds to the resolution (in pixels per inch) of the target device when export
barcode images to a raster graphics file format (JPEG, GIF, PNG, TIF and BMP).

Remarks
When you export the barcode image into a raster graphics file format, such as JPG, GIF and PNG, you are
converting the drawing commands (device independent) to an array of pixels which are device dependent.
The size of a pixel varies based on the device and usually is measured by dot per inch (dpi). A laser printer
usually has a high resolution of 300 dpi, while the screen has a low resolution of 96 dpi. As a result, an image
may have different physical sizes when displayed on the screen than printed. The greater the resolution is,
the bigger the file size and the accurate of the details. We suggest you set this property to the value which
matches your printer.
The default value for this property is 300.

See Also
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7.23. Rotation Property

Description
Returns or sets a value indicating how to rotate the working area.

Remarks
This property controls how the working area is rotated. Valid rotation choices are:

Table 7.4. Roation Options

Cosntant Value Description

mbxRTZeroDegree 0 No rotation

mbxRTAntiClockwise_90 1 Rotate at 90 degrees angle counterclockwise

mbxRTAntiClockwise_180 2 Rotate at 180 degrees angle counterclockwise(upside
down)

mbxRTAntiClockwise_270 3 Rotate at 270 degrees angle counterclockwise
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7.24. ShowCheckDigit Property

Description
Determines whether the checksum characters will be shown on the human readable portion. This option is
effective to selected symbologies only.

Remarks
Different symbologies have different rules regarding check digit. For some symbologies, check digit is part of
the data and should always be included in the human readable text. Some symbologies allow optional check
digit. Some symbologies require check character not be displayed at all.

• Check digit is part of data and is always displayed.
This category includes UPC-A, UPC-E, EAN-13, EAN-8, Bookland, and UCC/EAN-128. This property
has no effect on these symbologies.

• Check digit is required, but not treated as part of data and is never included in the human readable
text.
This category includes Code 128, Telepen and Telepen Numeric.

• Check digit is required, and can be optinally included into the human readable text.
This category includes Code 93, Code 11, POSTNET, PLANET and MSI/Plessey.

• Check digit is optional, and can be optionally included in the human readable text.
This category includes Code 39, Code 39 Full ASCII, HIBC.

In version 3.6, there are some noteable changes:
• Previously, HIBC barcodes may turn off its check digit in the human readable display (although the

check digit always appear in the barcode). After 3.6, the check digit is always included in the human
readable text, as required by the standard.

• Before 3.6, whether a UCC/EAN-128 check digit is calculated depends on UccEanOptionalCheckDigit.
After version 3.6, the check digit is always included in the human readable text.

See Also
Section 7.26, “ShowHRText Property”
Section 7.8, “ Code25OptionalCheckDigit Property ”
Section 7.9, “Code39OptionalCheckDigit Property”
Section 7.17, “I2of5OptionalCheckDigit Property”
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7.25. ShowComment Property

Description
Returns or sets a value that determines whether the symbol displays the comment portion.

Remarks
Toggle this property to turn on or turn off the display of the comment portion. Note that if this property is
FALSE, comment margins will not be included during the position calculation of other components, such as
working area, bar code image etc. If you want to have these margins participate the calculation and do not
want to see the comment, set Comment property to an empty string instead.
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7.26. ShowHRText Property

Description
Returns or sets a value that determines whether the symbol displays the human readable portion.

Remarks
Toggle this property to turn on or turn off the display of the human readable text.
Two dimensional barcodes do not have the concept of “human readable”. Consequently this property has no
effect on 2D barcodes.
Per standard, UPC-A, UPC-E, EAN-13, EAN-8 barcodes and their supplements should always have the
human readable as an integrated part of the image. In versions prior to 3.2, you can not produce these
barcodes without visible human readable, even you set ShowHRText to FALSE. This behavior has changed
since version 3.2. Unless you have absolute reason to turn it off, you should set ShowHRText to TRUE when
creating these types of barcodes.

Note The width of human readable text portion never exceeds the barcode length.
If the barcode length is too small, the text will wrap into multiple lines. If this is not
desired, reduce the font size, or place the human readable text into comment and
adjust comment margin properties to increase the width of comment box so that the
text stays in one line.
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7.27. Symbology Property

Description
Returns or sets a value indicating the type of the barcode format (symbology) to be generated by the ActiveX
control.

Remarks
The Barcode Creator currently supports the following symbologies:

Table 7.5. Symbology Options

Constant Value Description

mbxCode39 0 (default) Code 39 (43 character set)

mbxCode39_Full_ASCII 1 Code 39 Full ASCII

mbxCode39_HIBC 2 Code 39 Mod 43 (Health Industry
Bar Code)

mbxCodaBar 3 Codabar

mbxCode93 4 Code 93

mbxCode128 5 Code 128

mbxUCC_EAN_128 6 UCC/EAN 128

mbxInterleaved_2of5 7 Interleaved 2 of 5 (ITF25)

mbxUPC_A 8 UPC-A

mbxUPC_E 9 UPC-E

mbxEAN_13 10 EAN/JAN-13

mbxEAN_8 11 EAN/JAN-8

mbxBookland 12 Bookland

mbxTelepen 13 Telepen

mbxTelepenNumeric 14 Telepen Numeric (double density)

mbxPostnet 20 PostNET (barcode used by USPS)

mbxPlanet 21 Planet (used by USPS for package
tracking)

mbxRoyalMail 22 Royal Mail (U.K. Postal)

mbxMSI_Plessey 30 MSI/Plessey

mbxCode25 31 Code 25

mbxCode11 32 Code 11

Some symbologies only encode certain limited set of characters, such as digits. Some symbologies impose
limit on the data length; some require checksum characters. If you are not familiar with the symbologies you
are working on, refer to Chapter 8, Barcode Technologies to get some hands-on information.
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7.28.  SymbolMarginTop, SymbolMarginBottom,
SymbolMarginLeft, SymbolMarginRight Properties

Description
These four properties control the margins around the symbol boundary (including barcode, human readable
and comment).

Remarks
These four parameters control the margins around the symbol (barcode, human readable and comment).
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7.29. TexAlignment Property

Description
Returns or sets a value indicating how the human readable text is aligned.

Remarks
This property controls how the text in the human readable portion is aligned. Valid alignment choices are:

Table 7.6. TexAlignment Options

Constant Value Description

mbxAlignLeft 0 Left alignment (default). Align the text with left edge of the
comment box.

mbxAlignRight 1 Right alignment. Align the text with the right edge of the
comment box.

mbxAlignCenter 2 Center alignment. Align the text with the center of the comment
box

mbxAlignJustify 3 Justify alignment. Align the text to both edge of the comment
box.

Because of the unique character arrangement in UPC/EAN symbologies, this property does not apply to those
symbologies: UPC-A, UPC-E, EAN-13 and EAN-8.
The barcodes below illustrate the effects of TexAlignment:

See Also
Section 7.16, “Font Property”
Section 7.26, “ShowHRText Property”
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7.30. TextOnTop Property

Description
Returns or sets a value that determines whether the human readable text is placed above the barcode image
or below the image.

Remarks
The default value for TextOnTop is FALSE ,which places the human readable text below the barcode. To place
the human readable text above the barcode, set TextOnTop to TRUE.

See Also
Section 7.16, “Font Property”
Section 7.26, “ShowHRText Property”
Section 7.29, “TexAlignment Property”
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7.31. UccEanOptionalCheckDigit Property

Description
Deprecated since version 3.6.

Remarks
Before version 3.6, This property kicks in when all the following conditions are met: (1) The current
symbology is set to UCC_EAN_128. (2) The data element contains an AI of 00 (SSCC-18) or 01(SCC-14).
(3) The data length is 1ess than the required. The check digit is calculated based on Mod 10 algorithm and
appended to the end of the data part. The check digit also appears in the human readable text.
In version 3.6 and above, this property kick in automatically when the program finds that the input is 1 digit
short. Setting the property does not change the program behavior.



Chapter 8. Barcode Technologies

8.1. Introduction
Barcode has been widely adopted across all major industries. A conventional barcode is a machine readable
symbol consisting of a series of parallel, adjacent bars and spaces. The basic barcode structure features
leading and trailing quiet zones, a start character, one or more data characters, one or more check characters
(optional) and a stop character.
Barcode has a long development history that spanned half a century. During the evolution process, many
formats have been developed and adopted by industries. Around a dozen of them are actively used today.
The term “symbology” is the scientific name for the barcode format. Different symbologies have different
characteristics, such as the encoding efficiency and character set. The character set defines what kind of
data the symbology encodes. Typically there are four types of character sets: (1) numeric. Only digits
can be encoded. (2) alpha-numeric. The symbology is capable of encoding numbers, letters plus several
punctuations. (3) full ASCII. All characters in the ASCII set, with value between 0 and 127, can be encoded.
(4) Binary. Binary character set includes all 256 characters in a 8-bit single byte character set. Most of two
dimensional symbologies are capable of encoding arbitrary binary data.
Some symbologies may impose length requirements. For example, UPC-A encodes the numeric data of exact
12 digits.
Two dimensional symbologies are usually capable of encoding thousands of characters.
Monterey Barcode Creator supports the following symbologies:

Table 8.1. Symbologies supported by Monterey Barcode Creator

Symbology Also Known As

Code 39 Code 3 of 9, AIAG, USS Code 39

Code39 Full ASCII Code 39 Extended

HIBC Code 39 HIBC, LOGMARS

Codabar Rationalized Codabar

Code 93  

Code 128 USS-128, C-128

GS1-128 UCC 128, EAN 128

Interleaved 2 of 5 ITF, ITF-14, I 2 of 5

UPC-A  

UPC-E  

EAN-13  

EAN-8  

Bookland  

Telepen, Telepen Numeric  

Postnet, Planet  
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Symbology Also Known As

Royal Mail UK Postal Code, RM4SCC

MSI/Plessey Plessey Code

Code 25 Industry 25, Code 2 of 5

Code 11  

You can purchase symbology standards directly from AIM Inc. The web address of AIM is  http://
www.aimglobal.org1.

8.2. Code 39
Code 39 (also known as USS Code 39, Code 3 of 9) is the first alpha-numeric symbology developed to be used
in non-retail environment. It is widely used to code alphanumeric information, such as the model number,
etc. It is designed to encode 26 upper case letters, 10 digits and 7 special characters:

A, B, C, D, E, F, G, 
H, I, J, K, L, M, N, O, P, Q, 
R, S, T, U, V, W, X, Y, Z
0, 1, 2, 3, 4, 5, 6, 7, 8, 9
-, ., *, $, /, +, %, SPACE.

Each code 39 symbol begins with a start character and ends with a stop character. Traditionally the start/stop
characters are represented by asterisk character (*). Due to this reason, some applications include asterisks in
the human readable text. The asterisks are not part of the encoded message and should not appear within the
message.

Code 39 allows an optional checksum digit based on modulo 43 algorithm. The health industry has adopted
the use of the check character for health applications and these types of barcodes are often referred as HIBC.

  Property Code39OptionalCheckDigit specifies whether an additional check digit should be added to the
barcode. Another property, Code39StartStopChars,  when it is set to TRUE, adds the traditional start/stop
characters (*) to the beginning and the end of the human readable text.

8.3. Code 39 Full ASCII
The Code 39 Full ASCII (sometimes also referred as Code 39 extended) is an extension to normal code 39.
It is capable of encoding all 128 ASCII characters. It uses shift characters to combine two normal code 39
characters to encode a character not in the normal code 39 character set. The barcode generated is compatible
with normal code 39, so a scanner must be configured to Full ASCII mode to read the barcode correctly.

1 http://www.aimglobal.org

http://www.aimglobal.org
http://www.aimglobal.org
http://www.aimglobal.org
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Code 39 Full ASCII supports entering control characters using special character input method. You can use
a back slash \ plus 3-digit decimal ASCII code to enter a control character. For example, the following input
encodes digits 123, followed by a NUL character and letters abc:

Data Input: 123\000abc

8.4. Code 39 HIBC
Code39 HIBC is exactly the same as normal Code39, except that Code39OptionalCheckDigit property  is set
to TRUE. The standard also says that the starting character in the message must be a plus (+) symbol. Monterey
Barcode Creator automatically adds this plus sign (+) if the encoded message does not meet this requirement.
The HIBC standard requires that the checksum digit to appear in the human readable. To satisfy this
requirement, your program should explicitly set property ShowcheckDigit to TRUE to create a compliant HIBC
symbol.
Setting Code39OptionalCheckDigit to FALSE does not affect the resulted barcode.

8.5. Codabar
Codabar is a variable length symbology which encodes a character set of 16 letters ( 0-9, -, $, :, /, +). It is
dubbed as NW-7 in Japan. You may choose one of these four start/stop characters in your symbol: A, B, C and
D. If you do not specify the start/stop characters, Monterey Barcode Creator uses A and B as the start/stop
characters, respectively. No check digit is required.

8.6. Code 93
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Code 93 is a variable length symbology that is capable of encoding all 128 ASCII characters. Code 93 offers
higher density than Code 39. It has the same native character set as Code 39 (43 characters), but it uses
additional 4 shift characters to encode other characters. Code 93 features 2 checksum characters. Start/Stop
characters are also required.
Code 93 supports special character input method. See Code 39 Full ASCII section for details on how to escape
control characters.

8.7. MSI/Plessey, Code 25 and Code11
These are rather obsolete symbologies which only encode numeric data. There is no advantage to use them
except for application backward compatibility. More information can be found at Morovia barcode library at 
http://www.morovia.com/education/2.

2 http://www.morovia.com/education/

http://www.morovia.com/education/
http://www.morovia.com/education/
http://www.morovia.com/education/
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8.8. UPC-A,UPC-E and UPC Supplements
The UPC-A barcode is the most common and well-known symbology in North America. You can find it on
the cartons of virtually every consumer goods in your local supermarket, as well as books, magazines, and
newspapers. A short form is called UPC-E. Each symbol may have 2-digit or 5-digit supplement to encode
additional information.

UPC-A encodes 11 digits of numeric data along with a trailing check digit, for a total of 12 digits of barcode
data.
A UPC-A number consists of four elements: (1) the Number System; (2) the manufacturer code; (3) the
product code; (4) the check digit. Normally the number system digit is printed to the left of the barcode,
and the check digit to the right. The manufacturer and product codes are printed just below the barcode,
separated by the guard bar.
The UPC-E barcode is the short form representation of a UPC number. It reduces the data length from 12
digits to 6 digits by compressing the extra zeros. It is suited for identifying products with small packages.
A UPC-E barcode has 6 digits with an implied number system 0. The first 5 digits are calculated based on a
conversion algorithm described below. The last digit is the check digit of the original UPC-A symbol.
Both UPC-A and UPC-E symbols allow for a supplemental two- or five-digit add-on barcode. This add-on
barcode usually encodes a price or a sequence number. To include a supplemental message, append it to the
main message with a vertical bar (|) to separate it from the main message. The supplemental message must
consist of exact two or five digits.

Table 8.2. Examples of UPC-A, UPC-E and Supplement

Message Symbol Created

90123678812 UPC-A

90123678812|02 UPC-A with 2-digit add on

0123456 UPC-E

0123456|95000 UPC-E with 5-digit add on
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8.9. EAN-13, EAN-8 and EAN Supplements
EAN is designed by the International Article Numbering Association (EAN) in Europe. It is an extension
to UPC-A to include the country information. The only difference between UPC-A and EAN-13 is that the
number system in UPC-A is a single digit varying from 0 through 9, whereas an EAN-13 number system
consists of two digits ranging form 00 to 99.

EAN-13 encodes 12 digits of numeric data along with a trailing check digit, for a total of 13 digits data.
An EAN-13 number consists of four elements: (1) the Number System; (2) the manufacturer code; (3) the
product code; (4) the check digit. Normally the number system digit is printed to the left of the barcode,
and the check digit to the right. The manufacturer and product codes are printed just below the barcode,
separated by the guard bar.
EAN-8 is the short version of EAN-13, the same as UPC-E vs. UPC-A. While they look very similar, some
differences exist. UPC-E does not explicitly encode the first digit (NS), while EAN-8 encodes all 8 digits. From
barcode encoding/decoding perspective, an EAN-8 is not compatible with UPC-E. Moreover, although a UPC-
E number can be converted back to UPC-A, this is not the case for EAN-8. There is no defined method for
conversions between EAN-13 to EAN-8. An EAN-8 number is assigned in the same way as EAN-13.
An EAN-8 number contains 7 digits of message plus 1 check digit. The first two or three digits identify the
numbering authority; the remaining 4 or 5 digits identify the product.

Table 8.3. Examples of EAN-13, EAN-8 and Supplement:

Message Symbol Created

97802161594 EAN-13

978020161594|02 EAN-13 with 2-digit add on

71245126 EAN-8

71245126|95000 EAN-8 with 5-digit add on
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8.10. ISBN/Bookland
The International Standard Book Number (ISBN) has been invented for more than 30 years. It has experienced
exponential growth and remarkable success. Today, every book, magazine, cassette and CD bear an ISBN
number. Every item to be sold in bookstore is required to furnish an ISBN. The ISBN is used extensively
by publishers, retailers as wells as libraries to manage inventory. The ISBN is represented through an EAN
barcode, a.k.a. Bookland barcode plus an optional 5-digit (2-digit for magazines) add-on.

An ISBN is a 10 digit number preceded by the letters ISBN. The text is usually printed with OCR-A font. The
10-digit number is divided into four parts of variable length, which are separated by hyphens or spaces. The
four parts are Group Identifier, Publisher Identifier, Title Identifier and Check Digit respectively. Note that
the length of each part is not fixed, though the total length must be 10.
A Bookland symbol may have an optional 2-digit or 5-digit add-on symbol. To add the supplement, add them
at the end of the main message and separate the two parts with a vertical bar(|), in the same way as the UPC
and EAN supplements. For example, to encode an ISBN number 0-201-61595-9 with pricing information
53995, set the Message property to 0-201-61595-9|53995.

Note on 13-digit ISBN
Beginning on January 1, 2007, all 10-digit ISBNs are required to be re-expressed as a 13-digit number
(EAN-13). To convert a 10-digit ISBN to 13-digit EAN number, drop the last checksum digit of the 10-digit
ISBN number and add prefix 978 at the beginning. Calculate the EAN-13 check digit based on the result and
append this checksum digit to the end of the result. To create the barcode, use EAN13 symbology instead and
assign the 13-digit ISBN number to the message property.
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8.11. Code 128

Code 128 is a high-density alpha-numeric symbology. Since introduced in early 1980s, it has gained wide
popularity in many industries. UCC/EAN derives its retail carton tracking standard UCC/EAN 128 based on
Code 128 symbology.
Code 128 is a variable length, continuous symbology with multiple element widths. Every Code 128 symbol
has a check character. Each character is encoded with three bars and spaces, in total 11 modules.
In the most recent standard ISO/IEC 15417, Code128 is extended to encode all 256 characters of a single-byte
character set3. The default character set is ISO 8859-1 (Latin Alphabet No. 1).
Code 128 standard also defines four function codes for special purposes. FNC2 is used to tell barcode reader
to store the data and transmit with next symbol; FNC4 is used as a latch code word to switch into extended
ASCII mode. FNC3 is reserved for future use. FNC1 is used in UCC/EAN128 to act as UCC/EAN-128 identifier
and field delimiter.

8.11.1. How Monterey Barcode Creator Implements Code128
Monterey Barcode Creator allows encoding all 256 characters as well as 4 special symbol characters: FNC1,
FNC2, FNC3and FNC4.
Internally Code128 defines 3 character sets (A, B and C) to allow efficient encoding. Each character set contains
103 characters (including special symbol characters). A code128 symbol starts with one character set and
latches to a different set with a latch codeword. Since these three character sets overlap, it is possible to get
different barcodes with the same data encoded.
To allow space efficiency, during the encoding process, the Monterey Barcode Creator selects the proper
character sets and inserts necessary shift characters to make the symbol generated as short as possible.
Code128 requires a checksum character to ensure the data integrity. The checksum character has no meaning
to the end user. Monterey Barcode Creator does not transmit the checksum digit back to the human readable
text.

Note  The Monterey Barcode Creator always tries to create the shortest barcode.
For example, if Monterey Barcode Creator sees that some portion of the data is best
fit encoded with Code128 C,it automatically select character set C. The end user does
not have the control on how the data is encoded.

8.11.2. Tilde Codes
Under some circumstances, it is necessary to represent some characters with an ASCII-only format. This kind
of representation format is called escape sequence. For example, the four special Code128 symbol characters,
FNC1~FNC4, do not have corresponding ASCII values. Consequently the only way to enter them into the
Message property is through their escaped forms. Some applications and programming environments may
only accept printable ASCII characters, and control characters must be escaped.
Tilde code sequence is the only escape method supported in Monterey Barcode Creator version 3.2 and
above. The special character input method (escaping a character using a back-slash character followed by 3-
digit character value) present in previous versions is now deprecated.

3Published in year 2000, this standard is relative new to the industry. Not all scanners in the market support this feature.
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The tilde code consequences used in Code128 are listed as below:
~dnnn

When nnn corresponds to a numeric value between 0 and 255, the tilde code sequence represents a
character with value equal to nnn. For example, ~d032 represents a space character.

~~
Represents a tilde (~) character.

~1
Represents a FNC1 character. The tilde escape sequence can appear anywhere in the input.

~2
Represents a FNC2 character.

~3
Represents a FNC3 character.

~4
Represents a FNC4 character. FNC4 is used to encode extended ASCII characters. You do not need to enter
the FNC4 in most circumstances. Just pass the extended characters you'd like to encode.

~X
Represents a character value from 0 to 26. Replace the X like in the following example ~@ means character
ascii 0, ~A means character 1, ~B means character 2, ~C means character 3 and so on.

Note Due to the fact that each symbology encodes different character set, the tilde
code sequence varies from symbology to symbology. Refer to the tilde codes section
of each symbology to understand how to escape the character.
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8.12. UCC/EAN-128

8.12.1. Introduction
UCC/EAN-1284 encodes structured data proposed by various industry standard bodies and authorized by
GS1 organization. Each data type is identified with a numeric value, called Application Identifier (AI). Multiple
AIs and values can be concatenated together into one barcode, such as:
(01)19421123450011(15)991231(10)101234

The data above contains multiple AIs and values:
• 01 indicates that the value followed 19421123450011 is a SCC-14 number. 5

• 15 is the AI for Sell by Date. The value followed 991231 indicates that the Sell By Date is December 31,
1999.

• 10 is the AI for Batch Number. According to the specification, it is a variable length AI. Here the value
is 101234.

The AI value determines the meaning and the length of the value part. Many of them encode a predefined
length of data. For example, the SCC14 requires exact 14 digits and the Sell By Date requires exact 6 digits in
YYMMDD format.
When the data length can be derived from AI, it is not necessary to add field separator (FNC1) in the barcode
to separate two adjacent fields. However, if the first field has a variable data length, such a field separator is
required. And in many applications it is often desirable to have a field separator between two fixed-length
fields. The Code128 symbol character FNC1 serves this purpose.

8.12.2. How Monterey Barcode Creator Implements UCC/EAN-128
To understand each data field, the Monterey Barcode Creator requires you to enter the data in a special
format. The AI must be enclosed with parentheses. From the AI, Monterey Barcode Creator knows whether
a field has a fixed length or a variable length. For all variable-length fields, Monterey Barcode Creator inserts
field separator unless it is located at the end of the symbol.
The Monterey Barcode Creator also performs data validation on the AI and the data, if the AI is known to the
program.

Table 8.4. List of Known AIs

AI Name Constraint Short Name

00 SSCC (Serial Shipping Container Code) n2+n18 SSCC

01 Global Trade Item Number n2+n14 GTIN

02 GTIN of Trade Items Contained in a
logistic unit

n2+n14 CONTENT

10 Batch or lot number n2+an..20 BATCH/LOT

11 Production date (YYMMDD) n2+n6 PROD DATE

12 Due date (YYMMDD) n2+n6 DUE DATE

13 Packaging date (YYMMDD) n2+n6 PACK DATE

15 Best before date (YYMMDD) n2+n6 BEST BEFORE or SELL
BY

17 Expiration date (YYMMDD) n2+n6 USE BY OR EXPIRY

4As UCC/EAN orgnization changed its name to GS1, now the symbology is also called as GS1-128.
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AI Name Constraint Short Name

20 Product variant n2+n2 VARIANT

21 Serial number n2+an..20 SERIAL

22 Secondary data for specific health industry
products

n2+an..29 QTY/DATE/BATCH

240 Additional product identification assigned
by the manufacturer

n3+an..30 ADDITIONAL ID

241 Customer part number n3+an..30 CUST. PART NO.

242 Made-to-Order Variation Number n2+n..6 Variation Number

250 Secondary serial number n3+an..30 SECONDARY SERIAL

251 Reference to source entity n3+an..30 REF. TO SOURCE

253 Global Document Type Identifier n3+n13+n..17 DOC. ID

254 GLN Extension component n3+an..20 GLN EXTENSION

30 Variable count n2+n..8 VAR. COUNT

310n-369n (Trade and logistic measurements) n4+n6 --

337n Kilograms per square metre n4+n6 KG PER m2

37 Count of trade items contained in a logistic
unit

n2+n..8 COUNT

390(n) Amount payable - single monetary area n4+n..15 AMOUNT

391(n) Amount payable - with ISO currency code n4+n3+n..15 AMOUNT

392(n) Amount payable for a Variable Measure
Trade Item - single monetary unit

n4+n..15 PRICE

393(n) Amount payable for a Variable Measure
Trade Item - with ISO currency code

n4+n3+n..15 PRICE

400 Customer's purchase order number n3+an..30 ORDER NUMBER

401 Consignment number n3+an..30 CONSIGNMENT

402 Shipment Identification Number n3+n17 SHIPMENT NO.

403 Routing code n3+an..30 ROUTE

410 Ship to - deliver to Global Location
Number

n3+n13 SHIP TO LOC

411 Bill to - invoice to Global Location Number n3+n13 BILL TO

412 Purchased from Global Location Number n3+n13 PURCHASE FROM

413 Ship for - deliver for - forward to Global
Location Number

n3+n13 SHIP FOR LOC

414 Identification of a physical location Global
Location Number

n3+n13 LOC No

415 Global Location Number of the Invoicing
Party

n3+n13 PAY
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AI Name Constraint Short Name

420 Ship to - deliver to postal code within a
single postal authority

n3+an..20 SHIP TO POST

421 Ship to - deliver to postal code with Three-
Digit ISO country code

n3+n3+an..9 SHIP TO POST

422 Country of origin of a trade item n3+n3 ORIGIN

423 Country of initial processing n3+n3+n..12 COUNTRY - INITIAL
PROCESS.

424 Country of processing n3+n3 COUNTRY - PROCESS.

425 Country of disassembly n3+n3 COUNTRY -
DISASSEMBLY

426 Country covering full process chain n3+n3 COUNTRY - FULL
PROCESS

7001 NATO stock number n4+n13 NSN

7002 UN/ECE meat carcasses and cuts
classification

n4+an..30 MEAT CUT

703(s) Approval number of processor with ISO
country code

n4+n3+an..27 PROCESSOR # s4

7003 Expiration Date and Time n4+n10 EXPIRY DATE/TIME

8001 Roll products - width, length, core
diameter, direction, and splices

n4+n14 DIMENSIONS

8002 Electronic serial identifier for cellular
mobile telephones

n4+an..20 CMT No

8003 Global Returnable Asset Identifier n4+n14+an..16 GRAI

8004 Global Individual Asset Identifier n4+an..30 GIAI

8005 Price per unit of measure n4+n6 PRICE PER UNIT

8006 Identification of the component of a trade
item

n4+n14+n2+n2 GCTIN

8007 International Bank Account Number n4+an..30 IBAN

8008 Date and time of production n4+n8+n..4 PROD TIME

8018 Global Service Relation Number n4+n18 GSRN

8020 Payment Slip Reference Number n4+an..25 REF No

8100 GS1-128 Coupon Extended Code - NSC +
Offer Code

n4+n1+n5 -

8101 GS1-128 Coupon Extended Code - NSC +
Offer Code + end of offer code

n4+n1+n5+n4 -

8102 GS1-128 Coupon Extended Code - NSC n4+n1+n1 -

90 Information mutually agreed between
trading partners (including FACT DIs)

n2+an..30 INTERNAL

91-99 Company internal information n2+an..30 INTERNAL
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If the AI is not listed in the table above 6, Barcode Creator can not know whether its data length is fixed or
variable. Thus, the Monterey Barcode Creator treats the data as if its data length is variable and insert the field
separator FNC1 when this field does not end the symbol.
For example, suppose that you set Message to (01) 19421123450011(8019)123456(15)051210. The
Monterey Barcode Creator understands that 01 AI requires fixed-length 14 digits data and AI 15 requires
fixed-length 14 digits data. However, Monterey Barcode Creator does not understand the AI 8019 and treats
this field as if it has a variable length. The Monterey Barcode Creator inserts a field separator at the end of this
field (before AI 15).
Assuming that AI 8019 requires a fixed data length, you can tell Monterey Barcode Creator that the field has
a fixed data length by appending a tilde character ~ at the end of the field. For example, you can assign the
value below:
(01)94211234500122(8019)123456~(15)051210

When the Monterey Barcode Creator sees the ~, it treats the current field as fixed-length.
On the other side, if a known AI has a fixed data length but you'd like to have a field separator at the end of
the field, you can do so by adding an exclamation character at the end of field, such as:
(01)94211234500122!(8019)123456(15)051210

It forces a field separator to appear after the SCC14 number even AI 01 has a fixed data length and the field
separator is not required. Sometimes this field separator is desirable because it is easier for the application to
parse the input.
See the table below for the comparison among results produced by different inputs. The[ GS] is the scanner
output for FNC1 character.

Barcode Data input/Scanner output

(01)94211234500122(8019)123456~(15)051210
0194211234500122801912345615051210

(01)94211234500122!(8019)123456(15)051210
0194211234500122[ GS]8019123456[ GS]15051210

(01)94211234500122(8019)123456(15)051210
01942112345001228019123456[ GS]15051210

8.12.3. Auto Check Digit
Before version 3.6, Monterey Barcode Creator calculates mod10 check digits on SCC-14 and SSCC-18
numbers, but only When the property UccEanOptionalCheckDigit is TRUE. This behavior has been changed
since version 3.6. Now the program calculates mod 10 check digit automatically, regardless the value of
UccEanOptionalCheckDigit. This renders this property useless.

6This table was updated in version 3.6 to reflect the changes made since the first version came out.
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Barcode Creator performs check digit calculation on those AIs: 00, 01, 02, 410, 411, 412, 413, 414, 415, and
8018.

8.12.4. Input Format
To create the barcode correctly, you must enclose the AI with parentheses ( ). The Monterey Barcode Creator
only accepts numeric AI values. It reports an error when encountering a non-numeric character in the AI part.
If AI does not appear in the known list (see the table above), and you do not want the data treated as variable
length, you should tell so by appending a tilde character at the end of the field.
Sometimes, it is desirable to have the data separated by spaces in the human readable text. For
example, you may like to see the human readable text  (8101) 0 54321 1200(21)123456 instead of
(8101)0543211200(21)123456. You can create the desirable human readable text by entering the message
exactly like the one you'd like the human readable to be. Monterey Barcode Creator ignores the spaces during
the encoding, but preserves them in the human readable text, as the one below illustrates:

8.12.5. Validation
Monterey Barcode Creator performs the following validations during the encoding process:

• Check whether the AI is numeric.
• Check whether a data part follows the AI.
• If the AI is known to Monterey Barcode Creator and requires a fixed length of data part, check if the

data part has the correct length.
• Check whether the AI is enclosed with parentheses.
• If the AI is known to Monterey Barcode Creator and requires only numeric or alpha-numeric data,

check if the data part meets the requirement.
• If the AI is known to Monterey Barcode Creator and requires variable length of the data, check if the

length of the data exceeds the maximum size allowed.

8.12.6. Non-standard Application
If your application does not pass the validation, you can not use UCC/EAN-128 to encode the data.
Nevertheless, since UCC/EAN-128 encoding is based on Code128 symbology, you can encode the data
directly with Code128. Here are several hints you may consider when converting the EAN-128 data into a
Code128 input:

• An EAN-128 barcode starts with a FNC1 character. FNC1 can be entered with tilde code sequence ~1.
• If you'd like to have the field separator encoded between two adjacent fields, using FNC1 character to

separate two fields.
• Code128 is capable of encoding spaces. Do not enter spaces in the input if you do not want them

appear in the barcode.
• You may use tilde code sequences to enter extended ASCII characters. See Section 8.11, “Code 128” for

details.
For example, Code128 with message ~18101054321120021123456 produces the exact barcode as the one
using UCC/EAN-128 with message (8101)0 54321 1200(21)123456.
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Some non-standard applications do not encode the FNC1 in the starting message. When this is the case,
remove ~1 at the beginning of the input.
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8.13. Interleaved 2 of 5 (ITF25)
Interleaved 2 of 5 is a high-density numeric symbology. Some applications require a modulo 10 checksum
digit at the end of the message. Interleaved 2 of 5 uses an “interwinded” method to create barcodes and
consequently it requires the data length to be even. In order to meet this requirement, Barcode Creator
appends a MOD10 check digit when it finds that the input is in odd length. Otherwise, it encodes the data as
is.
Note that this behavior has changed since version 3.6. Previously, check digit is added only when property
I2of5OptionalCheckDigit is TRUE, otherwise a '0' is appended instead. The new implement allows you to enter
13 digits SCC-14 number to get a complete barcode with the check digit.
If the check digit is added, it always appears in the human readable text.
The input for Interleaved 2 of 5 allow spaces. The spaces are preserved in the human readable text but not
encoded into the barcode. Fro example, the barcode below is created on input 0 07 70007 0723. Note that
the last digit '9' is the check digit, which is calculated by the program.
Interleaved 2 of 5 is widely used to encode Shipping Container Code (SCC-14), which contains exact 14 digits.
When it is used for encoding SCC-14 numbers, it is also called ITF-14. 

You can add bear bars to the barcode by setting BearerBars to TRUE.
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8.14. POSTNET

POSTNET (Postal Numeric Encoding Technique) encodes a US numeric address code (also called Zip code)
which may contain 5, 9 or 11 digits - frequently referred as Zip, Zip+4 and Zip+6.
POSTNET is a height-modulated symbology which encodes the data in the height of the barcode instead
of the width. Monterey Barcode Creator produces POSTNET barcode based on USPS standard. The
height of each bar and the pitch between two adjacent bars are fixed and can not be modified. Changing
NarrowBarWidth and BarHeight yields no effect. Although Monterey Barcode Creator produces human
readable if you desire, keep in mind that USPS standard does not allow human readable text under the
barcode.
The Monterey Barcode Creator accepts non-numeric input but filters them out at the time of the encoding. It
adjusts the length by adding trailing zeros to meet the length requirement. You may take the advantage by
assigning the full address line to the Message instead of passing only digits. For example, data input Monterey
Park, CA 91755-1688 yields an identical barcode as message 917551688.





Chapter 9. Technical Support
Morovia offers a wide variety of support services. To help you save time and money when you encounter a
problem, we suggest you try to resolve the problem by following the options below in the order shown.

• Consult the documentation. The quickest answer to many questions can be found in the Morovia
product documentation.

• Review the tutorial and sample applications. The tutorial steps you through the development process
for a typical barcode application. The sample applications provide working code examples in several
programming languages. All sample applications are extensively commented.

• Access Morovia Online. Morovia Online provides a knowledge base which documents the frequently
asked questions and a web forum.
The web address for knowledge base is http://support.morovia.com. You can ask question at support
forum at http://forum.morovia.com.

• Contact Morovia Technical Support Service. The Technical Support service is provided for free up to
180 days after the purchase. Email Morovia support engineers at support@morovia.com.

Note  If you purchased your software from our reseller, check to see if they provide
support services before contacting Morovia.

Support services and policies are subject to change without notice.

http://support.morovia.com
http://forum.morovia.com




Appendix A. Software License Agreement
IMPORTANT-READ CAREFULLY: This Morovia End-User License Agreement ("EULA") is a legal agreement
between you (either an individual person or a single legal entity, who will be referred to in this EULA as
"You") and Morovia Corporation (referred as "Morovia") for the Morovia software product that accompanies
this EULA, including any associated media, printed materials and electronic documentation (the "Software
Product"). The Software Product also includes any software updates, add-on components, web services and/
or supplements that Morovia may provide to you or make available to You after the date You obtain Your
initial copy of the Software Product to the extent that such items are not accompanied by a separate license
agreement or terms of use. By installing, copying, downloading, accessing or otherwise using the Software
Product, You agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do
not install, access or use the Software Product; instead, you should return it to your place of purchase for a
full refund.

The Software Product is protected by intellectual property laws and treaties.

1. GRANT OF LICENSE. This Section of the EULA describes Your general rights to install and use the
Software Product The license rights described in this Section are subject to all other terms and conditions of
this EULA.

General License Grant to Install and Use Software Product. You may install and use one copy of the Software
Product on a single computer, device, workstation, terminal, or other digital electronic or analog device
("Device"). You may make a second copy of the Software Product and install it on a portable Device for the
exclusive use of the person who is the primary user of the first copy of the Software Product. A license for the
Software Product may not be shared.

Alternative License Grant for Storage/Network Use. As an alternative to the rights granted in the previous
section, You may install a copy of the Software Product on one storage Device, such as a network server,
and allow individuals within Your business or enterprise to access and use the Software Product from other
Devices over a private network, provided that You acquire and dedicate a license for the storage Device
upon which the Software Product is installed and each separate Device from which the Software Product is
accessed and used. A license for the Software Product may not be used concurrently on different Devices.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Copy Protection. The Software Product may include copy protection technology to prevent the unauthorized
copying of the Software Product or may require original media for use of the Software Product on the Device.
It is illegal to make unauthorized copies of the Software Product or to circumvent any copy protection
technology included in the Software Product.

Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer,
decompile, or disassemble the Software Product, except and only to the extent that such activity is expressly
permitted by applicable law notwithstanding this limitation.

Separation of Component Parts. The Software Product is licensed as a single product. Its component parts
may not be separated for use on more than one Device unless expressly permitted by this EULA.

No rental, leasing or commercial hosting. You may not rent, lease, lend or provide commercial hosting
services to third parties with the Software Product.

Software Transfer. Except as specified in this Section, the initial licensee of the Software Product may make
a one-time permanent transfer of this EULA and Software Product only directly to an end user. This transfer
must include all of the Software Product (including all component parts, the media and printed materials,
any upgrades, this EULA, and, if applicable, the Certificate of Authenticity). Such transfer may not be by way
of consignment or any other indirect transfer. The transferee of such one-time transfer must agree to comply
with the terms of this EULA, including the obligation not to further transfer this EULA and Software Product.
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Termination. Without prejudice to any other rights, Morovia may terminate this EULA if You fail to comply
with the terms and conditions of this EULA. In such event, You must destroy all copies of the Software
Product and all of its component parts.
For Trial Software. This is not free software. You are hereby licensed to use this software for evaluation
purposes without charge for limited functions. If you want use this software with full functions a registration
fee is required. You must completely remove the software from your computer upon the expiration of the trial
period.
3. INTELLECTUAL PROPERTY RIGHTS. All title and intellectual property rights in and to the Software
Product (including but not limited to any images, photographs, animations, video, audio, music, text, and
"applets" incorporated into the Software Product), the accompanying printed materials, and any copies of the
Software Product are owned by Morovia or its suppliers. All title and intellectual property rights in and to
the content that is not contained in the Software Product, but may be accessed through use of the Software
Product, is the property of the respective content owners and may be protected by applicable copyright or
other intellectual property laws and treaties. This EULA grants you no rights to use such content. If this
Software Product contains documentation that is provided only in electronic form, you may print one copy of
such electronic documentation. You may not copy the printed materials accompanying the Software Product.
4. BACKUP COPY. After installation of one copy of the Software Product pursuant to this EULA, you may
keep the original media on which the Software Product was provided by Morovia solely for backup or
archival purposes. If the original media is required to use the Software Product on the Device, you may make
one copy of the Software Product solely for backup or archival purposes. Except as expressly provided in this
EULA, you may not otherwise make copies of the Software Product or the printed materials accompanying
the Software Product.
5. APPLICABLE LAW. If you acquired this Software Product in Canada, unless expressly prohibited by local
law, this EULA is governed by the laws in force in the Province of Ontario, Canada; and, in respect of any
dispute which may arise here under; you consent to the jurisdiction of the federal and provincial courts
sitting in Toronto, Ontario. If this Software Product was acquired outside Canada, then local law may apply.
6. No LIABILITY FOR DAMAGES. In no event shall the author of this Software be liable for any damages
whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss
of business information, or any other pecuniary loss) arising out of the use of or inability to use this product,
even if the Author of this Software has been advised of the possibility of such damages.
Because some states' jurisdictions do not allow the exclusion or limitation of liability for consequential or
incidental damages, the above limitation may not apply to you. In this case the Author of this Software will
only be liable for the amount of money you spent for this SOFTWARE PRODUCT in exchange for the return
of the product, all copies, registration papers and manuals, and all materials that constitute a transfer of
ownership from the customer back to the Software Author.



Glossary
AIM Abbreviation for AIM International, a world-wide trade organization for

manufacturers and providers of bar code products, services and supplies.

ASCII The character set and code described in American National Standard Code
for Information Interchange, ANSI X3.4-1977. Each ASCII character is
encoded with seven bits.

BMP BMP is a raster graphics format developed by Microsoft. BMP is the
native grahpics format for Windows users. A BMP image data can be
uncompressed, or compressed using RLE scheme. The file size is generally
much bigger than other types since the compression scheme is not very
effective.

Check character Synonymous to “Check digit”.

Check digit A character whose value is calculated based on certain algorithm and used
for the purpose of performing a mathematical check to ensure the accuracy
of the data. In many symbologies this character has a numeric value hence
the name.

Code 39 Code 39 (also known as USS Code 39, Code 3 of 9) is the first alpha-numeric
symbology developed to be used in non-retail environment. It is widely
used to code alphanumeric information, such as the model number etc. It is
designed to encode 26 upper case letters, 10 digits and 7 special characters.

Code 93 Code 93 is a discrete, variable length, self-checking symbology. It is derived
from Code 39 with major enhancements. Code93 encodes all 127 ASCII
characters and does not require special scanner configuration.

EAN-13 EAN is designed by the International Article Numbering Association (EAN)
in Europe. It is an extension to UPC-A to include the country information.
EAN-13 encodes 12 digits of numeric data along with a trailing check digit,
for a total of 13 digits of barcode data.

EAN-8 EAN-8 is the short version of EAN-13, the same as UPC-E vs. UPC-A. An
EAN-8 number contains 7 digits of message plus 1 check digit. Different
from UPC-E, an EAN-8 number is allocated separately and can not be
derived from an EAN-13 number.

EMF Acronym for Enhanced MetaFile. A newer 32-bit version of Windows
MetaFile. EMF contains frame information and contain more drawing
commands then its predecessor, WMF.

Extended character A character other than a 7-bit ASCII character. An extended character is a 1-
byte code point with the eighth bit set (ordinal 128 through 255).

GIF Acronym for Graphics Interchange Format. GIF is a bitmap image format
encoding up to 256 distinct color in a 24-bit RGB color space. GIF employs
LZW data compression, which does not lose image data during the
compression process.
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GS1 Organization that oversees the allocation of U.P.C. and EAN numbers.
Formerly known as Uniform Code Council (UCC).

GTIN Acronym for Global Trade Item Number. A 14-digit number that uniquely
identifies a trade item.

HIBC Acronym for Health Industry Bar Code. A bar code format based on code 3
of 9 adopted by health industry.

JPEG JPEG stands for Joint Photographic Experts Group. It is commonly referred
as an image format.

PNG Acronym for Portable Network Graphics. PNG is a bitmap image format that
employs lossless data compression.

POSTNET POSTNET (Postal Numeric Encoding Technique) encodes a US numeric
address code (also called Zip code) which may contain 5, 9 or 11 digits - often
called Zip, Zip+4 and Zip+6.

Start/Stop character A special bar/space pattern that provides the scanner with start and stop
reading instructions as well as scanning direction indicator. Most linear
symbologies require start/stop characters included in the barcode.

TIF Acronym for Tagged Image File Format. Also abbreviated as TIFF. TIF is a
bitmap image format capable of storing multiple images. It is widely used in
scanning, faxing and word processing.

UCC/EAN-128 UCC/EAN-128 was developed to provide a worldwide standard for
exchanging data between different companies. UCC/EAN-128 provides a
method of defining the meaning of the data through a list of "Application
Identifiers" a.k.a. AIs.

UPC-A The UPC-A barcode is the most common and well-known symbology in
North America. UPC-A encodes 11 digits of numeric data along with a
trailing check digit, for a total of 12 digits of barcode data.

UPC-E The UPC-E barcode is the short form representation of a UPC-A number. It
reduces the data length from 12 digits to 6 digits by compressing extra zeros.

USPS Abbreviation for U.S. Postal Service.

WMF Acronym for Windows Metafile. WMF is a graphics file format on Microsoft
Windows. WMF is a vector graphics format which stores drawing commands
instead of color information of pixels.
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U
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V
View, 13
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status bar, 14
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